


  

 الأوبدًٌّ اٌبشٔبِحّٔٛرج ٚطف 

 اٌبشٔبِح  سؤٌت -1

الً ا ِٓ ِظبدس حغزٌت سٛق اٌؼًّ اٌؼشٌسؼى لسُ اٌؼٍَٛ اٌّبٌٍت ٚاٌّظشفٍت اٌى اْ ٌىْٛ ِظذس

ببٌىٛادس اٌؼٍٍّت اٌّخخظظت ببلأػّبي اٌّبٌٍت ٚالاػّبي اٌّظشفٍت ٚفمب اٌى ِٛاطفبث ئداسة اٌدٛدة 

اٌشبٍِت ٚالاػخّبد الاوبدًٌّ ٚػٍى ضٛء اٌّؼبٌٍش اٌخً حشا٘ب ٚصاسة اٌخؼٍٍُ اٌؼبًٌ ٚاٌبحث اٌؼًٍّ ِٓ 

ِإسسبحٗ ٌلأخشاط فً اخً إٌٙٛع ببٌٛالغ الالخظبدي ٌٍبٍذ ٚحفؼًٍ دٚس اٌمطبع اٌخبص ٚحشدٍغ 

سبحت اٌؼًّ ٚاِخلان صِبَ اٌّببدسة ٚاٌخحٛي ِٓ حبٌت اٌدّٛد اٌى اٌٛضغ اٌزي ٌىْٛ فٍٗ لطبػب سٌبدٌب 

 فً ػٍٍّت اٌخٍّٕت الالخظبدٌت اٌّسخذاِت 

 رسالة البرنامج -2
أٌ سسبنخ انمسى هٍ ثُبء وَشش انًؼشفخ و تطىَش انًهبساد انؼهًُخ و انؼًهُخ ثبنمطبع انًبنٍ و انًظشفٍ و 

الاستثًبسٌ نتهجُخ يتطهجبد انسىق انًحهُخ و انؼبنًُخ يٍ خلال انتًُض و انتفىق فٍ انتؼهُى انجبيؼٍ و يىاكجخ 

بلاد انًؼشفخ انؼهًُخ )الاداسَخ و انًحبسجُخ و انتجذَذ و الاثذاع فٍ انتذسَس و أغُبء انجحث انؼهًٍ فٍ يج

 انًبنُخ و الالتظبدَخ(.

 

 

 اهداف البرنامج  -3

   .تؼضَض انفهى انتحهُهٍ نهطبنت نهؼهىو انًبنُخ و انًظشفُخ -1

 .تؼضَض لذسح انطبنت فٍ أتخبر انمشاس و اداء انًهبساد الاداسَخ و انًبنُخ -2

 .فٍ ػًهه انًهٍُ يستمجلاا تًُُخ يهبساد انطهجخ فٍ انًؼشفخ و انكفبءح  -3

تأهُم انطهجخ انًتخشجٍُ نًتطهجبد سىق انؼًم ثًب َؤيٍ يشبسكتهى الاَجبثُخ و انفبػهخ  -4

 .فٍ تطىَش و تحسٍُ التظبد انجهذ

 .الاستمبء ثبنُظبو انتؼهًٍُ و انتشثىٌ نهطهجخ و تشسُخ يجبدئ انتؼهُى و انتؼهى -5

 

 

 
 

 الاعتماد البرامجً -4

 فً طور التمدٌم دلا ٌوج

 



  

 

 

 

 المؤثرات الخارجٌة -5

 دلا ٌوج

 

 هٌكلٌة البرنامج -6

 ملاحظات النسبة المئوٌة وحدة دراسٌة الممرراتعدد  هٌكل المؤسسة

 اساسً %2112 14 7 متطلبات مؤسسة

 اساسً %2125 9 3 متطلبات كلٌة

 اساسً %2148 66 27 متطلبات لسم

 اساسً %2121 3 1 التدرٌب الصٌفً

    - اخرى

 

 البرنامجوصف  -7

 الساعات المعتمدة اسم المقرر او المساق رمز المقرر او المساق السنة /  المستوى
 عملي نظري 

المرحلة الاولى/الكورس 
 الاول

ECB 400 3 مبادئ التصاد - 
MGB 300 3 مبادئ ادارة اعمال - 

MCB 100 3 مبادئ محاسبة - 

STB200 3 مبادئ احصاء - 

HDB 009  انسان /دٌممراطٌةحموق  2 - 

ARB 009 2 لغة عربٌة/نحو - 

FBB 601 ( المراسلات و النصوص المالٌةE) 2 - 

المرحلة الاولى/الكورس 
 الثاني

ECB 400 3 مبادئ التصاد - 
MGB 300 3 مبادئ ادارة اعمال - 

MCB 100 3 مبادئ محاسبة - 

STB200 3 مبادئ احصاء - 

FBB 601  النصوص المالٌة المراسلات و

(E) 
2 - 

COB 099 1 2 مفاهٌم و تطبٌمات الحاسوب 
المرحلة الثانية/الكورس 

 الاول
ACB 107 3 الرٌاضٌات المالٌة - 

FBB 602 3 نمود و مصارف - 



  

 

 

CLB 009 2 لانون تجاري - 

FBB 604 1مالٌة عامة  2 - 

MGB 306 1ادارة مالٌة  2 - 

FBB 605  1مصرفٌة/لواعد بٌانات  2 1 

ACB 102 /1المحاسبة المتوسطة  3 - 
JHA013 2 جرائم حزب البعث - 

المرحلة الثانية/الكورس 
 الثانية

FBB 604 2مالٌة عامة  2 - 

FBB 603 3 مؤسسات مالٌة و مصرفٌة - 

FBB 609 ً3 تسوٌك مصرف - 

MGB 306 2ادارة مالٌة  2 - 

EC 001 2 تجارة الكترونٌة - 

FBB 605 /2لواعد بٌانات مصرفٌة  2 1 

ACB 102 /3  2المحاسبة المتوسطة - 

FBB 610  سٌاسات نمدٌة و الجهاز
 المصرفً

3 - 

المرحلة الثالثة/الكورس 
 الاول

FBB605 ًمالً التصاد لٌاس  2 - 

FBB 611 1تموٌل شركات   2 - 

FBB610 3 اسالٌب كمٌة - 

ACB 113 /1نظام محاسبً موحد  2 - 

FBB608 3 عملٌات مصرفٌة - 

FBB607 1محاسبة مصرفٌة  2 - 

ACB109 3 1محاسبة تكالٌف - 

المرحلة الثالثة/الكورس 
 الثانية

FBB615 3 أسواق مالٌة - 

FBB611 /2تموٌل شركات  2 - 

FBB17 3 ادارة المخاطر المالٌة - 

ACB613 /2نظام محاسبً موحد  3 - 

FBB113 الاستثمار تمٌٌم لرارت  3 - 

FBB607 2محاسبة مصرفٌة  2  
ABC109 /2محاسبة تكالٌف  3 - 

المرحلة الرابعة/الكورس 
 الاول

FBB216 3 نظم معلومات محاسبٌة - 

FBB617 3 محفظة استثمارٌة - 

ABC111 /1التدلٌك و الرلابة المالٌة  2 - 

FBB18 2 معاٌٌر مصرفٌة دولٌة - 

MSR  اسالٌب البحث أخلالٌات و
 العلمً

2 - 

ACB116 /3 1المحاسبة الإدارٌة - 

FBB606  2 1مصارف اسلامٌة  
المرحلة الرابعة/الكورس 

 الثانية
TOB514 2 مشروع بحث - 

ACB111 /2التدلٌك و الرلابة المالٌة  2 - 



  

 

 

ACB116 /2المحاسبة الإدارٌة  3 - 

FBB19 ً3 تموٌل دول - 

FBB606  2اسلامٌةمصارف  2 - 

AA001 3 دراسة و تمٌٌم المشارٌع - 

 

 انًتىلؼخ نهجشَبيجيخشجبد انتؼهى   -8

 اٌّؼشفت

 يؼشفخ انطبنت نًفهىو الإداسح انًظشفُخ. – 1 

 لذسح انطبنت ػهً تمُُى يذي َجبح انسُبسخ انًبنُخ وانُمذَخ.– 2 

 فٍ انخذيخ انًظشفُختكبنُف انجىدح تًكٍُ انطهجخ يٍ تحهُم  – 3

 

  اٌّٙبساث

 اٌ َتؼشف ػهً انًفبهُى انًبنُخ وانًظشفُخ .    - 1

 اٌ َظُف الاحتُبجبد نتطىَش انؼًم انًظشفٍ .   -2

 اٌ َحهم يُظىيخ انتكبنُف  والاسثبح فٍ انؼًم انًظشفٍ   -3

 

 اٌمٍُ 

 اٌخٛاطً اٌٍفظً- -1

 .اٌىلاَ فً ٚثمت ذالأفىبس بٛضٛاٌخؼبٍش ػٓ  مذسة ػٍىاٌ   

 ضّٓ ِدّٛػت بثمت اٌؼًّ اٌدّبػًاٌؼًّ - -2

 اٌخحًٍٍ ٚاٌخّحٍض )اٌخحمٍك(  -3

 ٌّشىٍت. حلااٌّببدئ ٚ اٌحمبئك ٌخأسٍسٚػًٍّ  بشىً ِٕٙدً اٌّؼٍِٛبث خّغ 

 ِببدسة-4

 اٌّطشٚحت يٚاٌحٍٛالأفىبس  ٚضغٚاٌفشص  ححذٌذاٌّببدسة ٚ ػٍىٚاٌمذسة اٌؼًّ  ػٍى ٍتاٌذافؼ

 الاحظبي اٌىخببً-5

 اٌىخببت بٛضٛذ فً ٔفسه اٌخؼبٍش ػٓ لبدسة ػٍى

 خٕظٍُ اٌٚ اٌخخطٍط-6

 ػٍى ٔحٛ فؼبي بٚحٕفٍزٌ٘لأٔشطت اٌخخطٍط  لبدسة ػٍى

 اٌّشٚٔت-7

 ثٚبٍئباٌّخغٍشة  عِغ الأٚضباٌخىٍف بٕدبذ  

 ئداسة اٌٛلج-8

 ) اٌّٙبَ، ٚححذٌذ أٌٌٚٛبث  بفؼبٌٍت جئداسة اٌٛل



  

 

 

 

 اسخشاحٍدٍبث اٌخؼٍٍُ ٚ اٌخؼٍُ -9

 طشَمخ انمبء انًحبضشاد . -1

2- Student Center  

 (Teams Project)  انًجبيُغ انطلاثُخ -3

 (Work shopوسش انؼًم )  -4

 (Brainstorming Ideas) ػظف الأفكبس  -5

 ( Learning Technologies on Campus) انتؼهى الانكتشوٍَ داخم انحشو انجبيؼٍ  -6

 ( experiential learningانتؼهى انتجشَجٍ ) -7

 ( Application Learningتطجُك انتؼهُى ( -8

 طشائك انتمُُى    -12

 Examsالايتحبَبد انشهشَخ وانفظهُخ  -1

2- Learning Matrix ) يظفىفخ انتؼهى ( 

3- CAT )انتغزَخ انشاجؼخ يٍ انطلاة ( 

4- Learning Triangle) يثهث انتؼهى( 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 
 
 
 
 

 

 

 
 



  

 

 

 انهُئخ انتذسَسُخ -11

 اػضبء انهُئخ انتذسَسُخ

          

انًتطهجبد  انتخظض انشتجخ انؼهًُخ

/انًهبساد انخبطخ 

 )اٌ وجذد(

 اػذاد انهُئخ انتذسَسُخ

 يحبضش يلان خبص ػبو

  ِلان حبسٛة حٍّٕت الخظبدٌت الخظبد حسن حسٌناحّذ خًٍٍ  .دا

  ِلان حبسٛة كلي ازمات اقتصاد عبد نصيف ا.د. جواد كاظم 

  ِلان حبسٛة دولي اقتصاد ا.د. عبد الخالق دبي الجبوري

 ا.م.د.أيهاب عبد السلام محمود
 حمود

  ِلان حبسٛة الاحصاء الحصين احصاء

  ِلان حبسٛة سياسات نقدية اقتصاد فهد ا.م.د. نصر حمود مزنان

  ِلان حبسٛة اقتصاد نفط اقتصاد الدليميد. حيدر علي محمد ا.

  ِلان حبسٛة نظرية محاسبية محاسبة احمد ا.م.د. اسعد منشد محمد

علوم  محمد رضا محسن م.د.ظلال
 حاسبات

  ِلان حبسٛة شبكات

  ِلان حبسٛة تكاليف محاسبة عباس م.د. زينه حمزة خضير

  ِلان حبسٛة مالية ومصرفية اقتصاد م.د. علي فلاح حمزة

علوم  م. فرح حسين محمد
 حاسبات

  ِلان حبسٛة تكنولوجيا الدعلومات

  ِلان حبسٛة اعمالادارة  ادارة اعمال م. هند عبد الامير احمد

  ِلان حبسٛة ادارة جودة ومعرفة ادارة اعمال م.م.علي حسن هادي

  ِلان حبسٛة الترويح تربية رياضية م.م.سرمد فاضل عبد الرحيم

  ِلان حبسٛة تكاليف محاسبة م.م.مثال كريم كاظم

ِبٌٍت ٚ  م.م. احمد صالح كاظم

 ِظشفٍت
  ِلان حبسٛة ِبٌٍت ٚ ِظشفٍت

ِبٌٍت ٚ  مصطفى حبيب عبيدم.م. 

 ٔمذٌت
  ِلان حبسٛة ِبٌٍت ٚ ٔمذٌت

ِبٌٍت ٚ  م.م. امير احمد ناصر

 ِظشفٍت
  ِلان حبسٛة ِبٌٍت ٚ ِظشفٍت

  ِلان حبسٛة لبْٔٛ لبْٔٛ م.م. ناظم جواد راشد

  ِلان حبسٛة الخظبد الخظبد م.م. نبيل تكليف اسكندر
 

 



  

 

 

 
 

 انتطىَش انًهٍُ

 

 /التدرٌس الجددتوجٌه اعضاء هٌئة 
ٌتم توجٌة اعضاء الهٌئة التدرٌسٌة الجدد و الزائرٌن و المتفرغٌن و غٌر المتفرغٌن على مستوى المسم 

من خلال عمد الندوات و رش العمل و المحاضرات التعرٌفٌة وادخالهم دورات طرائك التدرٌس بالنسبة 
 للتدرٌسٌن الجدد ودورات تدرٌبٌة 

 

 هُئخ انتذسَسانتطىَش انًهٍُ لأػضبء 

انمسى جبد و حشَض ػهً تكشَس يىضىع تطىَش يهبساد انتذسَسٍ نذي اػضبء انهُئخ انتذسَسُخ و َتبثغ 

 َتبئج انتؼهُى و انتؼهى ثظىسح يستًشح و يذي تطىس هؤلاء انتذسَسٍُُ يٍ انُبحُخ انؼهًُخ و انؼًهُخ

 يؼُبس انمجىل

 اٌمبٛي اٌّشوضي ٚاٌذساسبث اٌّسبئٍت

 

 

 ِظبدس اٌّؼٍِٛبث ػٓ اٌبشٔبِحاُ٘ 

اٌبشٔبِح ِٕشٛس ػٍى ِٛلغ اٌمسُ ٚ اٌىٍٍت ٚحُ اػذاد ٘زا اٌبشٔبِح ِٓ لبً ٚصاسة اٌخؼٍٍُ اٌؼبًٌ ٚ اٌبحث 

 اٌؼًٍّ ٌٚخُ ِخببؼت حٕفٍزٖ ِٓ لبً اٌسٍذ سئٍس اٌمسُ 

 

 خطت حطٌٛش اٌبشٔبِح

 دٚسي ٌٍٛلٛف ػٍى اٌسٍبٍبث  اْ ٚخذث اٌمسُ ٚ اٌىٍٍت حشٌض ػٍى ِشاخؼت ٚ حمٍٍُ ٘زا اٌبشٔبِح بشىً



  

 

 

 مخطط مهارات الدنهج
 مخرجات التعلم الدطلوبة من البرنامج 

اساسي ام  اسم الدقرر رمز الدقرر السنة/الدستوى
 اختياري

 القيم لدهاراتا ةالدعرف 
 4ج 3ج 2ج 1ج 4ب 3ب 2ب 1ب 4أ 3أ 2أ 1أ

المرحلة 
الاولى/الكورس 

 الاول

ECB 400 اساسي مبادئ التصاد *     *    *   
MGB 300 اساسي مبادئ ادارة اعمال   *  *      *  
MCB 100 اساسي مبادئ محاسبة *     *    *   
STB200 اساسي مبادئ احصاء  *   *     *   

HDB 009 اختياري حموق انسان /دٌممراطٌة   *     *   *  
ARB 009 اختياري لغة عربٌة/نحو    *  *    *   
FBB 601  المراسلات و النصوص

 Eالمالٌة 
   *    *  *    اختياري

المرحلة 
الاولى/الكورس 

 الثاني

FBB 601  /2    *     *    * اساسي مبادئ التصاد 
ECB 400 اساسي مبادئ ادارة اعمال *     *   *   * 
MGB 300 اساسي مبادئ محاسبة *     *     *  
MCB 100 اساسي مبادئ احصاء *    *       * 
STB200  المراسلات و النصوص

 (Eالمالٌة )
   *    *   *   اختياري

FBB 601 اختياري مفاهٌم و تطبٌمات الحاسوب    *   *    *  
المرحلة 

الثانية/الكورس 
 الاول

ACB 107  1عامةمالٌة     *    *    * اساسي 
FBB 602  الرٌاضٌات المالٌة و الفائدة

 البسٌطة
   *     *  * * * اساسي

CLB 009 1ادارة مالٌة    *   *    * * * اساسي 
FBB 604 اساسي نمود و مصارف * * *   *       
MGB 306 /1المحاسبة المتوسطة   *           اساسي 
FBB 605  تجاريلانون     *    *    * اساسي 
JHA013 اختياري جرائم حزب البعث    *   *    *  
ACB 102 /1لواعد بٌانات مصرفٌة    *   *      * اساسي 

المرحلة 
الثانية/الكورس 

 الثانية

FBB 604 2مالٌة عامة    *   *      * اساسي 
FBB 603 اساسي مؤسسات مالٌة *      *   *   
FBB 609 ًاختياري تسوٌك مصرف  *    *     *  



  

 

 

MGB 306 2ادارة مالٌة    *     *    * اساسي 
EC 001 اختياري تجارة الكترونٌة    *    *    * 

FBB 605 /2المحاسبة المتوسطة    *    *     * اساسي 
ACB 102  سٌاسات نمدٌة و الجهاز

 المصرفً
 *     *      * اساسي

FBB 610  اساسي 2بٌانات مصرفٌة/لواعد *      *    *  
المرحلة 

الثالثة/الكورس 
 الاول

FBB615 اساسي عملٌات مصرفٌة  *   *        
FBB611 1محاسبة تكالٌف    *  *      *  اساسي 
FBB17 1محاسبة مصرفٌة    *   *     *  اساسي 

ACB613 اختياري اسالٌب كمٌة      *    *   
FBB113  لٌاسًالتصاد    *     *    * اساسي 
FBB607 /1نظام محاسبً موحد    *     *    * اساسي 
ABC109 1تموٌل شركات   *   *     *   اختياري 

المرحلة 
الثالثة/الكورس 

 الثانية

FBB216 اساسي أسواق مالٌة   *    *    *  
FBB617 اساسي تمٌٌم لرارت الاستثمار *    *    *    
ABC111 اختياري ادارة المخاطر المالٌة    *    *    * 
FBB18 /2محاسبة تكالٌف  *     *     *  اساسي 

MSR /2نظام محاسبً موحد  *     *     *  اساسي 

ACB116 /2تموٌل شركات   *     *     * اختياري 
المرحلة 

الرابعة/الكورس 
 الاول

FBB216 /ً1تموٌل دول   *     *     * اساسي 
FBB617  دراسات جدوى و تمٌٌم

1المشروعات/  
  *     *     * اساسي

ABC111 /1التدلٌك و الرلابة المالٌة    *     *   *  اختياري 
FBB18 /1المحاسبة الإدارٌة    *     *   *  اساسي 
MSR ً1/التصاد لٌاس    *     *    * اساسي 

ACB116  اخلالٌات و اسالٌب البحث
 العلمً

 *      *    *  اساسي

 TOB514 ًاساسي تموٌل دول  *     *    *  
ACB111  دراسات جدوى و تمٌٌم

 المشروعات
  *     *   *   اساسي

ACB116 /2التدلٌك و الرلابة المالٌة     *    *    * اساسي 
FBB19 /2المحاسبة الإدارٌة             * اساسي 



  

 

 

FBB606 ً2/التصاد لٌاس       *    *   اساسي 
AA001 اساسي أعداد بحث التخرج   *       *   

 

 



 

  

 

 
 

 2:   لىاػذ انجُبَبد انًظشفُخانًمشس اسى

 

 ACB 102: انًمشس سيض

 

 : فظهٍانسُخ / انفظم

 

 2224-2-5: انىطف هزا إػذاد تبسَخ

 

 : َىيٍانًتبحخ انحضىس أشكبل 5.
 

 45:   (انكهٍ) انىحذاد ػذد (/انكهٍ) انذساسُخ انسبػبد ػذد 6.
 

 (ٌذكر اسم من اكثر اذا ) الدراسً الممرر مسؤول اسم 7.

ب :الاسى ض س محمد  ل  لا ظ . د .                     و
   bus.thilal.m@uobabylon.edu.iq  : ًَُمالا

 
  ٍ ٍ انطبنت ي كُ ٍ تً فُه ف بَيج الأكسم وتىظ ٍ ثش الإستفبدح ي

 انًجبلاد انًحبسجُخ.

  ٍ فُه ف بَيج الأكسم وتىظ ٍ ثش ٍ الإستفبدح ي ٍ انطبنت ي كُ تً

 دساسخ انجذوي الإلتظبدَخ.

 .انتبكُذ ػهً اهًُته فٍ انجبَت انؼًهٍ نهًشاحم انلاحمخ 

 

 

 1 والمحاورة الالماء 11
 للتواصل بشكل مباشر مع الطلبة . استخدام برنامج التلغرام 21
 1المحاضرة شرح فً والسبورة الملم استخدام 31
 المختبر فً العملٌة المحاضرات 41

 
 
 
 
 
 
 
 
 
 

 



 

  

 

 

    
   

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

التعرف على واجهة برنامج 
2010ماٌكروسوفت اكسل   

 بالمكونات الطالب تعرٌف
للبرنامج الأساسٌة  

 الاول 3

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

شرح تبوٌب الصفحة الرئٌسٌة 
Home Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب الصفحة الرئٌسٌة 
)الحافظة, الخط, محاذاة, 
 الثانً 3 رلم, انماط(

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

تكملة  شرح تبوٌب الصفحة 
 Home Tabالرئٌسٌة 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب الصفحة الرئٌسٌة 
 )خلاٌا, تحرٌر(

 الثالث 3

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

شرح تبوٌب تخطٌط الصفحة 
Page Layout Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب تخطٌط الصفحة )نسك, 

تغٌٌر الحجم اعداد الصفحة, 
لغرض الملائمة, خٌارات 
 الورلة, ترتٌب(

 الرابع 3

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

 Insertشرح تبوٌب ادراج 
Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب ادراج )الجداول 
 ,الرسوم التوضٌحٌة(

 الخامس 3



 

  

 

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

تكملة شرح تبوٌب ادراج  
Insert Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب ادراج )مخططات 
 ,خطوط المؤشر(

 السادس 3

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

  الأمتحان الأول

 السابع 3

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

شرح تبوٌب الصٌغ 
Formulas Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب الصٌغ )مكتبة الدالات, 
لواعد كتابة الصٌغ الحسابٌة, 
 الثامن 3 عوامل الممارنة والمرجعٌة(

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

تكملة شرح تبوٌب الصٌغ 
Formulas Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 

)جملة اذا تبوٌب الصٌغ 
الشرطٌة, الأسماء المعرفة, 
 العاشر 3 تدلٌك الصٌغ, الحساب(

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

 Dataشرح تبوٌب بٌانات 
Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب بٌانات )احضار بٌانات 
 خارجٌة, الأتصالات(

عشر احدى 3  



 

  

 

  

تكملة شرح تبوٌب بٌانات 
Data Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
 تبوٌب بٌانات )فرز وتصفٌة(

عشر أثنً 3  

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

شرح تبوٌب مراجعة 
Review Tab 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب مراجعة )مجموعة 
تدلٌك, اللغة, تعلٌمات, 

تفصٌلً(تغٌٌرات, مخطط  عشر الثالث 3   

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

تكملة شرح تبوٌب عرض 
view 

معرفة  من الطالب تمكٌن
الأدوات الموجودة ضمن 
تبوٌب عرض )طرق عرض 
المصنفات, اظهار, 
عشر الرابع 3 تكبٌر/تصغٌر, نافذة(  

عمل+نظري)الاختبار

(ي  
مختبر+  محاضرة  

الثانً الفصل وامتحان مراجعة   

3 
 الخامس
 عشر



 

  

 

 
 وانشهشَخ وانشفىَخ انُىيُخ والايتحبَبد انُىيٍ انتحضُش يثم انطبنت ثهب انًكهف انًهبو وفك ػهً 221 يٍ انذسجخ تىصَغ

 انخ .... وانتمبسَش وانتحشَشَخ

 
   

 

 

 

 

 
https://business.uobabylon.edu.iq/department/dep_lectures.aspx?cdid=1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

 

 ماٌكروسوفت-اساسٌات الحاسوب وتطبٌماته المكتبٌة 
 2010اكسل 





1  

 

 

The Department of Banking and Financial Sciences seeks to be one of the sources 

of feeding the Iraqi labor market with scientific cadres specialized in financial and 

banking works in accordance with the specifications of comprehensive quality 

management and academic accreditation and in light of the standards considered by 

the Ministry of Higher Education and Scientific Research in order to advance the 

economic reality of the country and activate the role of the private sector. 

Encouraging its institutions to engage in the work arena, take the initiative, and 

move from a state of stagnation to a situation in which it is a leading sector in the 

process of sustainable economic development. 
 

 

 

 

 

The department's mission is to build and disseminate knowledge and develop 

scientific and practical skills in the financial, banking and investment sectors to 

meet the requirements of the local and global market through distinction and 

excellence in university education, keeping pace with innovation and creativity in 

teaching, and enriching scientific research in the fields of scientific (administrative) 

knowledge. And accounting, finance and economics). 
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1- Enhancing the student’s analytical understanding of financial and banking 

sciences. 

2- Enhancing the student’s ability to make decisions and perform administrative 

and financial skills. 

3- Developing students’ skills in knowledge and competence in their future 

professional work. 

4- Qualifying graduating students for the requirements of the labor market in a way 

that ensures their positive and effective participation in developing and improving 

the country’s economy. 

5- Improving the educational system for students and consolidating the principles 

of teaching and learning 
 

 

 

 

None in the process of submission 
 

 

 

 

nothing 
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Foundation 

requirements 
 

7 41 2140%   

Basic 

 

College requirements 

 

3 9 2120%  

Basic 

 

 

07 66 2118%  

Basic 

 

 
4 3 2124%  

Basic 

 

 
-    
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7.  

 

Level/Year 

Course or 
Module 
Code 

Course or Module Title  

 

Practical Theoretical 

First stage / first 

course 

 

ECB 400 
economics principles busines 

- 3 

MGB 300 
management principles 

- 3 

MCB 100 
Accounting principles 

- 3 

STB200 
Principles of Statistics human 

- 3 

HDB 009 
rights/democracy Arabic 

- 2 

ARB 009 
language/Grammar Financial 

- 2 

FBB 601 
Correspondence and Transcripts 

(E) 

- 2 

First 

stage/second 

course 

 

ECB 400 
Principles of Economics 

- 3 

MGB 300 
business management principles 

- 3 

MCB 100 
Accounting principles 

- 3 

STB200 
Principles of Statistics Financial  

- 3 

FBB 601 
Correspondence and Transcripts 

(E) 

- 2 

COB 099 
Computer concepts and 

applications 

1 2 

Second stage / 

first course 

ACB 107 
Computer concepts and 

applications 

- 3 
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 FBB 602 
Financial Mathematics 

- 3 

CLB 009 
Money and Banks 

- 2 

FBB 604 
Commercial law public finance1 

- 2 

MGB 306 
financial management1 

- 2 

FBB 605 
Banking Databases/1 

1 2 

ACB 102 
Intermediate Accounting/1 

- 3 

JHA013 
Jaraayim hizb albaeth 

- 0 

Second 

stage/second 

course 

 

FBB 604 
public finance2 

- 2 

FBB 603 
Financial and banking  

-  2 

FBB 609 
Financial and banking institutions 

- 3 

MGB 306 
banking marketing 

- 3 

EC 001 electronic trade - 2 

FBB 605 
Banking Databases/2 

1 2 

ACB 102 
Intermediate Accounting/2 

- 2 

FBB 610 
Monetary policies and the 

banking system 

- 3 

Third stage / first 

course 

 

FBB605 
financial econometrics 

- 2 

FBB 611 
Corporate Finance1 

- 2 

FBB610 
quantitative methods 

- 3 

ACB 113 
unified accounting system/1 

- 2 

FBB608 
banking operations 

- 3 

FBB607 
Bank Accounting1 

- 2 

ACB109 
Cost Accounting1 

- 3 
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Third stage / 

second course 

 

FBB615 
financial markets 

- 3 

FBB611 
Corporate Finance/2 

- 2 

FBB17 
financial risk 

- 3 

ACB613 
management unified accounting 

system/2 

- 3 

FBB113 
Evaluate investment decisions 

- 3 

FBB607 
Bank Accounting2 

- 2 

ABC109 
Cost Accounting/2 

- 3 

Fourth stage / 

first course 

 

FBB216 
accounting information systems 

- 3 

FBB617 
Investment portfolio 

- 3 

ABC111 
Audit and Financial Control/1 

- 2 

FBB18 
International Banking Standards 

- 2 

MSR 
Ethics and methods of scientific 

research 

- 2 

ACB116 
Islamic Banks 1 

- 3 

Fourth stage / 

second course 

 

FBB606 
research project 

- 2 

TOB514 
Audit and Financial Control/2 

- 2 

ACB111 
Management Accounting/2 

- 2 

ACB116 
International Finance 

- 3 

FBB19 
Islamic banks2 

- 3 

FBB606 
Study and evaluation of projects 

- 2 
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1 - The student’s knowledge of the 

concept of banking management. 

2 - The student’s ability to evaluate 

the success of fiscal and monetary 

policy. 

3 - Enabling students to analyze the 

costs of quality in banking service 

 

1 - The student’s knowledge of the concept of banking management. 

2 - The student’s ability to evaluate the success of fiscal and monetary 

policy. 

3 - Enabling students to analyze the costs of quality in banking service 

 

 

1- To become familiar with 

financial and banking concepts. 

2- To classify the needs for 

developing the banking business. 

3- To analyze the system of costs 

and profits in banking 

 

1- To become familiar with financial and banking concepts. 

2- To classify the needs for developing the banking business. 

3- To analyze the system of costs and profits in banking 

 

 

1 -Verbal communication 

The ability to express ideas clearly 

and confidently in speech. 

2- -Teamwork: Work confidently 

within a group 

3- Analysis and scrutiny 

(investigation) 

1 -Verbal communication 

The ability to express ideas clearly and confidently in speech. 

2- -Teamwork: Work confidently within a group 

3- Analysis and scrutiny (investigation) 

Collect information systematically and scientifically to establish facts and 

principles for a solution to a problem. 

4-Initiative 
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Collect information systematically 

and scientifically to establish facts 

and principles for a solution to a 

problem. 

4-Initiative 

Motivation to work and the ability 

to take initiative, identify 

opportunities, and develop ideas 

and solutions 

 

5-Written communication 

Able to express yourself clearly in 

writing 

6-Planning and organizing 

Able to plan and implement 

activities effectively 

7-Flexibility 

Successfully adapt to changing 

situations and environments 

8-Time management 

Manage time effectively and 

prioritize tasks 

 

Motivation to work and the ability to take initiative, identify 

opportunities, and develop ideas and solutions 

 

5-Written communication 

Able to express yourself clearly in writing 

6-Planning and organizing 

Able to plan and implement activities effectively 

 

7-Flexibility 

Successfully adapt to changing situations and environments 

8-Time management 

Manage time effectively and prioritize tasks 
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1- - Method of giving lectures 

2- Student Center  

3- Teams Project 

4-   Work sho 

5-  Brainstorming Ideas 

6- Learning Technologies on Campus  

7- experiential learning 

8- Application Learning  
 

 
 

 

1- Exams 

2- Learning Matrix 

3- feedback from students CAT 

4- Learning Triangle 



1
0 

 

 

 

  

 

 

    

Prof. Dr. Ahmed Khalil Hassan 
Economy 

Economic development 

Computer 
 

 

Prof. Dr. Jawad Kazem Abdel Nassif 
Economy 

I'm all in crises 
Computer 

 
 

Prof. Dr. Abdul Khaleq Dubai Al-Jubouri 
Economy 

international 
Computer 

 
 

Prof. Dr Haider Ali Muhammad  
Economy 

Oil economy 
Computer 

 
 

. Dr. Ihab Abdel Salam Mahmoud  
Counting 

Hippocampal 

statistics 

Computer 
 

 

Dr. Nasr Hamoud Maznan Fahd 
Economy 

Monetary policies 
Computer 

 
 

Dr. Asaad vocalist Muhammad 

Ahmed 

accounting Accounting theory 
Computer 

 
 

M.D. Dhalal Muhammad Reda 

Mohsen 

computer Sciences 

networks 
Computer 

 
 

M.D. Zeina Hamza Khudair Abbas 
accounting 

Costs 
Computer 

 
 

M.D. Ali Falah Hamza 
Economy 

Finance and 

Banking 

Computer 
 

 

M. Farah Hussein Muhammad 
computer Sciences 

information technology 
Computer 

 
 

M. Hind Abdel Amir Ahmed business 

management 

business management Computer 
 

 

M. M. Ali Hassan Hadi 
business 

management 
business management Computer 

 
 

M.M. Sarmad Fadel Abdel Rahim Physical 

Education 

Recreation 
 

Computer 
 

 

M.M.Mmethel Karim Kazim 
accounting 

Costs 
Computer 

 
 



1
1 

 

M.M. Ahmed Saleh Kazem 
Finance and 

Banking 

Finance and 

Banking 
Computer 

 
 

M.M. Mustafa Habib Obaid Financial and cash 
Financial and cash Computer 

 
 

M.M. Amir Ahmed Nasser 
Finance and 

Banking 

Finance and 

Banking 
Computer 

 
 

M.M. Nazim Jawad Rashid 
Law Law Computer 

 
 

M.M Nabil assigned to Iskandar 
Economy Economy Computer 

 
 

 

 

 

 

Orienting new faculty members/ 

New, visiting, full-time and part-time faculty members are guided at the department level through 

holding seminars, workshops, and introductory lectures, and introducing them to teaching methods 

courses for new teachers and training courses. 

 

 
 

 

The department is serious and keen to devote the issue of developing the teaching skills of 

faculty members and monitors the results of teaching and learning on an ongoing basis and 

the extent of the development of these teachers from a scientific and practical standpoint. 
 

 

 
 

  

Central admission and evening studies 
 

 

 
 



1
2 

 

 

 

 
 

 
 

      The department and college are keen to review and evaluate this program periodically to identify 

drawbacks, if any 

  

The program is published on the department and college website. This program was 

prepared by the Ministry of Higher Education and Scientific Research, and its 

implementation is followed up by the head of the department. 
 

 



 

 

 
Required program Learning outcomes 

 

Year/

Level 

 
Course 

Code 

 

Course Name 

 
g 

 

 

 

A1 A2 A

3 

A4 B1 B2 B

3 

B

4 

C

1 

C

2 

C3 C

4 

First stage / 

first course 
 

ECB 400 

economics principles busines 

Basic *     *    *   

MGB 300 

management principles 

Basic    * *      *  

MCB 100 

Accounting principles 

Basic *     *    *   

STB200 

Principles of Statistics human 

Basic  *   *     *   

HDB 009 

rights/democracy Arabic 

my choice    *    *   *  

ARB 009 

language/Grammar Financial 

my choice      *    *   

FBB 601 

Correspondence and Transcripts 

(E) 

my choice      *    *   

First 

stage/second 

course 

 

ECB 400 

Principles of Economics 

Basic *    *     *   

MGB 300 

business management principles 

Basic *     *   *   * 

MCB 100 

Accounting principles 

Basic *     *     *  

STB200 

Principles of Statistics Financial 

Basic *    *       * 

FBB 601 

Correspondence and Transcripts 

(E) 

Basic    *  *    *   



 

COB 099 

Computer concepts and 

applications 

Basic       *    *  

Second 

stage / first 

course 
 

ACB 107 

Computer concepts and 

applications 

Basic *    *    *    

FBB 602 

Financial Mathematics 

Basic * *  * *     *   

CLB 009 

Money and Banks 

Basic * *  *   *   *   

FBB 604 

Commercial law public finance1 

Basic * *  *  *       

MGB 306 

financial management1 

Basic           *  

FBB 605 

Banking Databases/1 

Basic *    *    *    

ACB 102 

Intermediate Accounting/1 

Basic *   *   *   *   

JHA013 

Jaraayim hizb albaeth 

Basic *   * *     *   

Second 

stage/secon

d course 
 

FBB 604 

public finance2 

Basic *      *   *   

FBB 603 

Financial and banking 

Basic *      *   *   

FBB 609 

Financial and banking institutions 

Basic  *    *     *  

MGB 306 

banking marketing 

Basic *    *     *   

EC 001 electronic trade Basic        *    * 
FBB 605 

Banking Databases/2 

Basic *     *    *   

ACB 102 

Intermediate Accounting/2 

Basic *      *     * 

FBB 610 

Monetary policies and the banking 

Basic *      *    *  



 

system 

Third stage 

/ first 

course 

 

FBB605 

financial econometrics 

Basic  *   *        

FBB 611 

Corporate Finance1 

Basic  *      *  *   

FBB610 

quantitative methods 

Basic  *     *   *   

ACB 113 

unified accounting system/1 

Basic      *    *   

FBB608 

banking operations 

Basic *    *     *   

FBB607 

Bank Accounting1 

Basic *    *     *   

ACB109 

Cost Accounting1 

my choice    *    *   *  

Third 

stage / 

second 

course 
 

FBB615 

financial markets 

Basic    *   *    *  

FBB611 

Corporate Finance/2 

Basic *    *    *    

FBB17 

financial risk 

Basic        *    * 

ACB613 

management unified accounting 

system/2 

my choice  *     *     * 

FBB113 

Evaluate investment decisions 

Basic  *     *     * 

FBB607 

Bank Accounting2 

Basic *     *     *  



 

 

Fourth 

stage / first 

course 
 

ABC109 

Cost Accounting/2 

my choice *     *     *  

FBB216 

accounting information systems 

Basic *     *     *  

 FBB617 

Investment portfolio 

Basic  *   *     *   

ABC111 

Audit and Financial Control/1 

my choice  *   *     *   

FBB18 

International Banking Standards 

Basic *    *     *   

MSR 

Ethics and methods of scientific 

research 

Basic  *    *      * 

Fourth 

stage / 

second 

course 

ACB116 

Islamic Banks 1 

my choice  *     *    *  

FBB606 

research project 

    *  *     *  

TOB514 

Audit and Financial Control/2 

Basic *    *    *    

ACB111 

Management Accounting/2 

Basic *            

ACB116 

International Finance 

Basic    *   *      

FBB19 

Islamic banks2 

Basic    *      *   

 

 

 Please tick the boxes corresponding to the individual program learning outcomes under evaluation. 
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 Course Description Form 
 

Course Name: Banking databases 

 

Course Code:BSC2 

 

Semester / Year: Course 

 

Description Preparation Date: 5-2-2024 

 

5. Available Attendance Forms:daily 
 

6. Number of Credit Hours (Total) / Number of Units (Total): 45 

 

7. Course administrator's name (mention all, if more than one name) 

Name:   

 

Email: 

 

  Enabling the student to benefit from 
the excel program and to employ it in 
the accounting and employment fields 
in the economic feasibility study. As 
well as emphasizing its importance in 
the practical aspect of the later stages1

 

 
 

 

  
 
   

 

 

 

 

 
 
 

  
 

Dr.Dhilal Mohammed Reda 

Bus.thilal.m@uobabylon.edu.iq 
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first 3 Introduce the 
student to the basic 
components of the 
program 

Learn the interface of 
Microsoft Excel 2010 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Second 3 Try out the tools on 
the Home tab 
(Clipboard, Font, 
Alignment, Number, 
Styles) 

Explanation of the 
Home Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Third 3 Try out the tools on 
the Home tab (Cells, 
Edit) 

Continuing the 
explanation of the 

Home Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Fourth 3 Try out the tools on 
the page layout tab 
(Layout, Page 
Setup, Resize for Fit, 
Sheet Options, 
Arrange) 

Explanation of the 
Page Layout Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Fifth 3 Use the tools on the 
Insert tab (Tables, 
Illustrations) 

Explanation of Insert 
tab  

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Sixth 3 Use the tools on the 
Insert tab (Charts, 
Sparklines) 

Continuing the 
explanation of the 

Insert Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Sevent

h 

3  the first exam Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 
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Eighth 3 Using the tools 
within the Formulas 
tab (functions library, 
rules for writing 
mathematical 
formulas, 
comparison and 
reference operators) 

Explanation of 
Formulas Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Ninth 3 Using the tools 
included in the 
Formulas tab (if 
condition clause, 
defined names, 
checking formulas, 
calculation) 

Complementing the 
explanation of the 

Formulas Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Tenth 3 Use the tools under 
the Data tab (Get 
External Data, 
Communications) 

Explanation of Data 
Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Elevent

h 

3 Use the tools under 
the Data tab (Sort and 
Filter) 

Complementing the 
explanation of the 

Data Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Twelfth 3 Use the tools on the 
review tab (audit 
group, language, 
comments, changes, 
outline) 

Explanation of the 
Review Tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Thirtee

nth 

3 Using the tools on 
the View tab 
(Workbook Views, 
Show, Zoom In / 
Zoom Out, Window) 

Explanation of the 
view tab 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

Fourtee

nth 

3  The second exam Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 
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Fifteent

h 

3 Introduce the 
student to the basic 
components of the 
program 

Learn the interface of 
Microsoft Excel 2010 

Lecture+ 

Laboratory 

Test 

(theoretical 

and Practical) 

 


